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The instant access to your sounds !

Welcome to SoundLib !

Before starting, just have a look at the basic concepts of SoundLib. It will take you 5 mn to have a good 
overview of the program !

You can start     quickly   with an easy tutorial that will take you directly to the main functions of SoundLib : 
create and use your first library !

For more help, click on any of these items :

How to...
Tips
Configuration : hardware and software
References     : glossary, menus, screens, synthesizers, troubleshooting

If you keep on using SoundLib, please remember you have to register !

Copyright (c) 1995 C. Le Brasseur
All mentioned trademarks are property of their respective owners



How to 
All the functions are grouped by theme :

- Library
- Banks
- Exchanges

Library :
Display the patch list

Display patch aliases

Display the Sounds of the day !

Display the category list

Create a library

Create a new category

Create an alias

Delete a patch card

Describe a patch

Hear a sound

Import patches into a library

Modify a patch card

Modify several patch cards.

Move patches from one category to another

Search for a sound

Update the category list

Banks :
Build a bank

Copy a bank into Cakewalk for windows

Create a single patch bank

Hear a sound

Import patches from a synth

Send a bank to a synth

Exchanges :
Copy a bank into Cakewalk for windows

Import patches into a library

Import patches from a synth

Send a bank to a synth





Creating a library

If you use several synths, make sure the current synth is the good one.
=> its name appears in the top head of the window.
If you want to use a different synth, open the Midi Devices list.

1. Open a new library :
Choose New in the Library menu.

2. Name it :
Choose Save or Save as in the Library menu.
Enter the name of the library.
=> The default name is newlib00.slb.
Click OK.
=> The name appears above the Library area. 
=> The number of cards and sounds is 0.

Now you can import patches in the library.

see also
New (Library menu)



Importing patches into a library
If your patches are stored in a synth, first you have to import them into SoundLib.

1. Open your library.
Choose Open in the Library menu.

2. Display the bank list :
If you just imported sounds from a synth to SoundLib your bank is already opened, otherwise :
Choose Open in the Bank menu

To import a whole patch bank :
1. Choose Add bank to lib in the Bank menu.

=> SoundLib displays a patch card template which allows you to pre-classify imported sounds.
The default category for new sounds is : "XX incoming". 

2. You can modify this classification.
Example : if you import a full bank or bass patches, select Instrument/Bass category

To import only some patches :
1. Select the patches you want to import in the library.

Choose Add selected patches to lib in the Bank menu.

=> SoundLib displays a card for each imported patch.
You can listen to each one by clicking on the TEST button.
The default category for new sounds is : "XX incoming". 

2. You can modify this classification as well as other fields.

3. Click OK to confirm each description => the patch is added to the library and you go to the next 
sound.
Click NEXT to go to the next patch without adding the activated patch.
CANCEL : not to add the leaving patches.

In any case, SoundLib checks imported patches to find duplicated ones. It displays the following 
window :

=> SoundLib only imports new patches in the library.



see also
more about duplicated patches detection
tips : importing patches quickly into a library
add bank to lib (Bank menu)
add selected patches to lib (Bank menu)



Importing patches from synth

If you use several synths, make sure the current synth is the good one.
=> its name appears in the top head of the window.
If you want to use a different synth, open the Midi Devices list.

1. Import the synth patches into SoundLib :
Choose Receive in the Midi menu.

=> The transfer is automatic and controlled by SoundLib
=> SoundLib automatically opens a bank and displays the imported patches.

2. You can save this bank :
Choose Save as in the Bank menu.

Now you can import these sounds into your library.

see also

configuration



Displaying the patch list
In this section, we show you how to display the whole patch list of your library or only a selected part of it.
You are going to identify aliases and homonyms. 

1. Open the library
Choose Open in the Library menu.
Select your file.
Click OK.

=> SoundLib displays the library name, the number of patches and cards.
=> Under the Library area, you can read Library opened.

2. To display :

. the whole library list:
Choose Search in the Patches menu.
=> SoundLib displays a searching card.
Dont't fill it ! Just click OK.
So, there is no criteria because you want to view all the patches.

=> Under the library area, you can read Search completed followed by the number of retrieved cards.

. a selected part of the library :
Choose Search in the Patches menu.
Fill the criteria you are interested in (see Searching for a patch)
Choose OK.

3. Identifying aliases and homonyms
A patch can be described differently, by several cards. 
We talk about aliases.
Example : the ANGELICA patch

Click this picture to find out aliases and homonyms.



In the Library area, you will notice that sounds described by several cards are followed by a + 
sign.
SoundLib also manages version numbers to allow you to distinguish homonyms patches
These patches are followed by the V letter and a different version number for each homonym.
Example : CHORALE-2 and ANGELBREATH patches

see also
displaying the patch aliases
searching for a sound



Displaying the patch aliases 
To display all the aliases of a patch :

1. Choose Group by patch in the Options menu.

2. Then choose Search in the Patches menu and
fill the criteria you are interested in.

3. Choose OK.

Example :
(Click this picture to find out aliases)

This display mode allows you to distinguish by number, which cards are describing the same 
sound.

In the example, you can see that there are 3 different ways of describing the ANGELICA patch :
2 named ANGELICA, 1 named BREATH, and the 3 cards are classified in 3 different categories !

A quick look at the numbers helps you in cheking aliases.
You can make them disappear by clicking on Group by patch in the Options menu.

see also
Group by patch (Options menu )



Hearing a sound
Warning : The following function allows you to send a patch to the synth.
This patch will overwrite the edit buffer ; so beware if you were editing a sound !
On the Kawai K1, K1m, K1r, K1II, there is no edit buffer addressable by midi, so on these synths the first location of 
the internal bank is overwritten when you use the test feature.

1. Open a library or a bank.

2. Select the patches you want to listen to.

3. Click the TEST button :
=> The patch is sent to the synth. You can play it.
To go to the next patch, click again on TEST or on the space bar.

see also
configuring SoundLib 
describing a sound



Describing a patch
To describe a patch, you must store it in a library then :

1. Select one or several patches in the lib.

2. Choose View/edit in the Patches menu . 

=> you can see the following card :

Click this picture to know more about each field.

3. Hear the sound by clicking on TEST.
=> the sound is sent to your synth. You can play it.

4. Fill in the fields you are interested in : choose the right category...
Enter your remarks in the Comments area.

5. Click OK to save your card and go to the next selected sound
or choose NEXT to go to the next selected sound without saving the activated card.

see also
displaying the category list
creating an alias



Creating an alias
Sometimes, it's difficult to describe a patch in a sinle way : however, SoundLib allows you to attach 
several cards to one patch !

1. Select one or several patches in the library.

2. Choose Add an alias in the Patches menu

3. You can see an alias card, with the same informations than the original one.
You can change the fields you want to, and click OK.

Example : 
ANGELICA patch can be attached both to the Voice/Choir and Voice/Female categories.
Click on this picture to find out aliases and homonyms.

So a sound can have several cards. We talk about alias cards
In the Library area, you will notice that sounds described by more than one card are followed by a + sign.

NB : Even when creating an alias card, Origin, Copyright and Redistrib. fields are attached to the one 
patch itself. So they always stay identical on all the alias cards of a patch.
If you modify those fields in one card, all the other cards attached to this patch, will be modified.

see also
displaying aliases
Add an alias (Patches menu)



Displaying the category list
To display the category list of the current library

choose Show categories in the Options menu .

=> SoundLib displays the list in a separated window. This list is always visible so you can view it while 
filling in a card.

note : this option allows to view the categories of the current library. Note that each library has its own 
category list.

see also
creating a new category
Show categories (Options menu)



Creating a new category
You must quit SoundLib to create a new category .

1. Quit SoundLib.

2. Open the SoundLib.ini file.

You will find this file in the installation folder of SoundLib.
Just double-click on it to launch Windows Notepad
You can see such a file :

3. Insert your category in this file, in the [CATEGORIES] section.
Separate each sub-category with a slash /.
Don't forget the = sign at the end of each line.

4. Save the SoundLib.ini file.

5. Close SoundLib.ini

6. Launch SoundLib again.

The new categories will be integrated into your future libraries. If you want to use them in an existing 
library, you must integrate them.

see also

displaying the category list





Integrating new categories in a library 
You just created new categories. To integrate them into an existing library :

1. Open the library :
Choose Open in the Library menu.

2. Update the categories :
Choose Add default categories in the Options menu.

=> New categories are added to the current library.

Note : If you create a new library, new categories will automatically be added.

see also

displaying the category list
Add default categories (Options menu)



Searching for a sound
1. Open your library :

Choose Open in the Library menu .

2. Perform a search :
Choose Patches in the Search menu.
You can see the following card : 
Click on the fields for more details.

3. Each field of the card can be used as a search criterion.
Fill in the informations in the fields you are interested in. You don't have to fill in all the fields. One 
criterion is enough. Empty fields are not taken in account. 
SoundLib searches are not case dependent. 

Note : If you don't fill in any field, SoundLib displays the whole library.

4. Click OK.
=> SoundLib displays the search result.

see also
Search (Patches menu )
Show categories (Options menu)
Group by patch (Options menu)
Displaying the patch list
Displaying the Sounds of the day !



Building a bank

If you use several synths, make sure the current synth is the good one.
=> its name appears in the top head of the window.
If you want to use a different synth, open the Midi Devices list.

You build a bank from a library :

1. Open your library
Choose Open in the Library menu .

2. Create a bank
Choose New in the Bank menu .
=> the new bank appears in the right area
or 
Open an existing bank to complete or modify

3. Display the library list
or search for special sounds.

4. In the Library area, select the patches you want to put in your bank.

5. Once you selected the sounds in the Library bank, go to the bank area and click on the locations 
you want to copy the sounds in.

6. Choose WRITE.
=> sounds are copied.
To add other sounds in your bank, repeat the operations from 3 to 6.

7. Don't forget to save the bank :
Choose Save or Save as in the Bank menu 

see also



sending a bank to a synth.
configuring SoundLib



Sending a bank to a synth
Warning : remember that if you upload a bank to your synth it will overwrite the previous patches ; so you 
should save them first.

1. Open the bank you want to transfer into the synth :
choose Open in the Bank menu .

2. Choose Send in the Midi menu.
=> the bank is sent to your synth.

Note : If you use several synths, make sure the current synth is the good one.
=> its name appears in the top head of the window.
If you want to use a different synth, open the Midi Devices list.

see also
configuring SoundLib



Modifying a patch card

1. In the library, select the patch card you want to modify.

2. Choose View/edit in the Patches menu
or double-click on the patch name.

3. Modify the fields you want to.

4. Confirm your modifications by clicking on OK.

see also
modifying several patch cards
displaying the category list



Modifying several patch cards
If you want to move patches from one category to another, add comments to several patches... you are 
going to modify their cards.
There are 2 ways of doing this :
- in a single operation : Global Edit
- validating the description for each sound : View/edit

To modify several patch cards in a single operation :

Example : you want to move all the Voice/Male sounds to the Voice/Choir category.

1. Select the patches you want to change in the library :
- Choose Search in the Patches menu.
- Fill in the criteria :
      ex : category = Voice/Male
- Choose OK.
=> SoundLib displays the searched patches.
- select all, by clicking on them.

2. Modify these cards simultaneously :
- Choose Global Edit in the Patches menu
- Modify the fields you want to.
      ex : category = Voice/Choir
- Confirm your modifications by clicking on OK.
=> SoundLib applies the modifications to all the selected cards.

Note :

SoundLib only modifies the fields you filled in on the Global Edit card. The other fields are leaved 
unchanged.

Even if several cards are attached to a patch, your modifications only concerns the selected cards, except
for the following fields :
- origin
- copyright
- redistrib
These informations are identical the same on every alias card, so they will be updated.

To modify several patch cards one by one :

1. In the library, select the patches you want to modify.

2. Choose View/edit in the Patches menu

3. Modify the fields you want to.

4. Confirm your modifications by clicking on OK and go to the next sound or
Click NEXT to go to the next card without saving the current one.

see also
displaying category list
View/edit (Patches menu)



Deleting a patch card
Be carefull with these commands !

To delete a patch card :

1. Select a patch in the library :
- Choose Search in the Patches menu 
- Fill in the fields you are interested in
- Choose OK.
=> SoundLib displays the search result.
- Select a patch you want to delete.

2. Delete the patch :
- Choose Delete in the Patches menu
- Confirm the removal by clicking on OK.
=> SoundLib delete the selected patch.

To delete several patch cards confirming the removal for each one :

1. Select the patches you want to delete in the library :
- Choose Search in the Patches menu.
- Fill in the criteria you are interested in
- Choose OK.

2. Delete the patches one by one :
- Choose Delete in the Patches menu
- Confirm the removal of the current patch by clicking on OK.
- Click NEXT to go to the next patch without removing the current one.
- CANCEL to stop.

To delete several patch cards simultaneously :

1. Select the sounds you want to delete in the library :
- Choose Search in the Patches menu 
- Fill in the criteria you are interested in
- Choose OK.

2. Delete all the patches simultaneously :
- Choose Delete in the Patches/Global menu
- Confirm the removal by clicking on OK.
=> SoundLib simultaneously deletes all the selected sounds.

Note :
If there is an alias left, you just delete the card, not the patch.

see also
Global deletion (Patches menu)



Creating a single patch bank
What is it for ?

Suppose you want to extract one patch from a bank, for instance to share it on Internet or to 
insert it as a sysex in a sequence.
You should save it in a single patch bank.

1. Open a bank :
Choose Open in the Bank menu.

2. Select this sound in your bank.

3. Create a single patch bank :
Choose Save single patch in the Bank menu.

=> SoundLib creates a bank and names it by default with the patch name.

see also
Save single patch (Bank menu ) 



Copying a bank to Cakewalk
This function gives you a direct access to the patches names of your banks, while working on Cakewalk 
tracks.

1. In SoundLib :
Open a bank :
Choose Open in the Bank menu.

2. Send it to Cakewalk :
Choose Copy to Cakewalk in the Bank menu
Note : If it is a new bank, SoundLib ask you to save it before sending it to Cakewalk.

=> In order to have the right patchs loaded on the synth, don't forget to do Midi/Send.

The following operations depend on Cakewalk version :

Cakewalk 2.0

Cakewalk 3.0 and Cakewalk Pro Audio.



Copying a patch bank to Cakewalk 2.0
Quit Cakewalk and launch it again to make him take the new patches names.

1. In Cakewalk, choose Patch names in the Settings menu.
=> The Configure Patch Name List window is displayed.
=> you should see the name of your bank.

2. For each port/channel, define which bank is used.
If you want this option to be permanent, check Save changes.
Click OK. 

3. In the window Track/measures, choose the appropriate port and channel.

4. In the column Patch, choose the patch you want using the + and - keys.



Copying a patch bank into Cakewalk 3.0 and Cakewalk Pro 

Audio
Note : This operation can seem boring but every step is given.
Look at the Cakewalk manual for more explanations.

Follow these instructions to integrate a new patch bank in Cakewalk.

If the bank is already in Cakewalk, you just have to update it and stop at the end of the 4th step.

To load the patch names of the bank :

1. In Cakewalk, choose Instruments in the Settings menu (v 3.0) 
or Assign Instruments (V. Pro Audio).
=> a window is displayed.

2. Click the Define Instruments button.
=> The Define instruments window is displayed
Click the Import button...

3. Choose the Soundlib.ins. file
Click OK.

4. Choose Soundlib as the instrument .
Click OK.

Note : With Cakewalk 3.0, you may need to confirm the replacement of the instrument SoundLib 
and the replacement of the Patch Name list you want to import.

(If you are updating a bank which is already in Cakewalk, you can stop here.)

To attach the patch list to an instrument :

5. Select the instrument in the scrolling list.

If the instrument isn't already defined in Cakewalk, you can either import it from a definition file as 
src.ins, or define it by clicking on New... 

6. Choose a bank number in the scrolling list Bank, or enter a new number.

7. In the Uses the Patch Names list, select the name of the bank coming from SoundLib.
=> the name of this bank is copied into the Bank list.

8. Close the Define Instrument window with the Close button 

To use patch names :

9. In the Assign Instrument window :
attach one (or several) port/channel to the instrument you want to define.
Click OK.

Note : of course, the instrument must be connected to this port and you must use it with this 
channel (see 10).

10. In the Tracks window :



define a new track with a port/channel the above instrument is connected to.

11. In the Bank column :
choose (with the + and - keys) the name of the bank loaded on the synth.

12. In the Patch column :
choose the patch you want to use with the + and - keys, or by double clicking on its name !

see also

configuration



Displaying the Sounds of the day
SoundLib offers you a random selection of 10 patches !

Choose Sounds of the day in the Patches menu.

=> 10 patches appear in the Library area !



Quick start
Here are the main functions of SoundLib. In this part, you will learn how to :

1. Build your sound library
2. Classify sounds
3. Search for a sound
4. Build a bank
5. Send banks to synth



Build your sound library
1. Create a library :

Choose New in Library menu

2. Name it :
Choose Save or Save as in the Library menu 
SoundLib will automatically name the library : newlib0_.slb. 
You should rename it using the Save as command.

3. Import sounds into the library :
Sounds are stored in a disk file or a synth :

 To import sounds from a disk file

 To import sounds from a synth

4. Display the sounds list :
Choose Search in the Patches menu ;
Click OK.

Now you can classify your sounds.

see also 

creating a library.



Importing sounds from a disk file
1. Choose Add Bank in the Library menu .

2. Select the directory and the file you want to import.
Click OK.

=> SoundLib displays a patch card template to pre-classify imported sounds.
Soundlib automatically put the new ones in the XX-incoming category.

3. You can change this pre classification.
Exemple : if you import a bank of bass patches, select the category : Instrument/Bass.

4. Click OK to confirm the pre classification.

=> the message window displays the list of imported sounds and shows the duplicated ones.

=> the number of patches appears above the Library area.

Now you are going to display the sounds list !



Importing sounds from a synth
1. If you use several synths, make sure the current synth is the good one.

=> its name appears in the top head of the window.
If you want to use a different synth, open the Midi Devices list.

2. Load patches from synth to SoundLib :
Choose Receive in the Midi menu .

=> The reception is automatic and controlled by SoundLib : you have nothing to do on the synth !
=> SoundLib automatically opens a bank and displays the imported sounds.

3. Import these patches into your library :
Choose Add bank to lib in the Bank menu.

=> SoundLib displays a patch card template that lets you pre-classify imported sounds.
Soundlib automatically put the new ones in the XX-incoming category.

4. You can modify this pre classification.
Exemple : if you import a full bank of bass patches, select the category : Instrument/Bass.

5. Click OK to confirm the classification.

=> the message window displays the list of the imported sounds and shows the duplicated ones.

=> the number of patches appears above the Library area.

Now, let's display the sounds list !



Classify sounds

1. Select the patches you want to classify.

2. Choose View/edit in Patches menu.
=> for each sound, you get the following card :
(Click on this picture to know more about each field)

3. Listen to the sound by clicking on the TEST button.
=> the patch is sent to your synth. You can play it.

4. Fill in the fields you want to.

5. Click OK to confirm your description and go to the next patch
or choose directly NEXT to go to the next patch without saving the activated card.

Now you can search for a sound.

see also 
tips : classifying lots of patches
more about categories



Search for a sound
1. Choose Search in the Patches menu 

2. You can search for a sound using any criteria of the patch card.
The search can be done on :
=> the name : enter the 1st letters or a part of it (preceded by *)
=> the category : select a category in the list
=> one or more comments words
=> the origin of the patch, etc...
Enter the informations in the fields you want to

Rq : If you don't select any criteria, SoundLib displays the whole library.

3. Click OK.

=>SoundLib displays the search result.

Now you can build a bank of patches.

see also 

more about searching for a sound



Build a bank
1. Create a new bank :

choose New in the Bank menu .
=> the new bank appears in the bank area.

2. In your library, select the patches you want to put into the bank.
(you can first search for a sound)

3. In the Bank area, click on the locations where you want to copy the selected patches.

4. Click WRITE
=> the bank is built.

5. Don't forget to save it :
Choose Save or Save as in Bank menu.

Now you can send this bank into a synth.

see also 
more about building a bank



Send a bank to a synth
Warning : remember that if you upload a bank to your synth it will overwrite the previous patches ; so you 
should save them first.

Choose Send in Midi menu 
=> the bank is sent to your synth.

Note :If you use several synths, make sure the current synth is the good one.
=> its name appears on the top head of the window.
If you want to use a different synth, open the Midi Devices list.

Now you know the main functions of SoundLib. For more help and details, go to the How to...section.



patch card

This window is used for :
searching sounds
viewing or editing a patch list
creating an alias card
deleting a sound
editing several cards simultaneously
specifying a patch card template



name

Patch name



version

Different patches with the same name (homonyms) will have different version numbers.



category

These fields allow you to view and choose a category for a patch.



favourite

Is this sound one of your favourite ? 



comments

Comments can be added to the patch description.

Exemple : a song title



origin

Where does the patch come from ?
The default origin is the name of the bank you imported the patch from.



copyright

Who does it belong to ?



redistrib.

Distribution : how can you use and distribute this patch : public domain, freeware, shareware...



TEST

This button sends the selected patch to your synth : so you can play it !



OK

Confirms what you did on the current patch and goes to the next selected patches.



NEXT

Cancels the action on the current patch and goes to the next selected patches.



CANCEL

Cancels the action on all selected patches.



References
Glossary

Commands

Screens :

This section presents the two main screens of SoundLib :

Main screen

Patch card

Synthesizers informations

Troubleshooting



Commands
Library menu 

The Library menu contains commands relating to creating, saving, building and closing libraries.

New
Open
Close
Save
Save as
Add bank
Add directory
Exit

Patches menu 
The Patches menu commands let you search for sounds and describe them.
You can fill in, modify or delete the patch cards.

Search

View/edit

Sounds of the day

Add an alias

Delete

Global/edit

Global/delete

Bank menu 

The Bank menu contains commands relating to creating, saving and closing your banks. You can also 
copy banks into Cakewalk.

New

Open

Close

Save

Save as

Save single patch

Copy to Cakewalk

Add bank to lib

Add selected patches to lib

Midi menu

The Midi menu commands allow you to send and receive data to/from your synth.

Send

Receive



Configure

Options menu

Group by patch

Show categories

Add default categories

Check library

Configure

Enter registration code



New (Library menu )
Use this command to create a library.
SoundLib automatically names this library newlib00.SLB.
The library name is displayed :

We advise you to rename it with a more significant name.
To do that, choose the Save as command

Note :
The library will be created for the current device, whoose name is displayed in the main window title. If 
you want to create a library for another device you have before to make it the current device using the 
Configure command from the Midi menu.

A library can hold about 7 000 cards.

see also
Creating a library
Troubleshooting



Open (Library menu)
Use this command to open an existing library.
Dialog box :
Filename

Type or select the name of the file to open.
SoundLib gives the .SLB extension to libraries.

Files
Lists all libraries of the current directory having an .SLB extension.

Directories
Select the library directory.

Note :
SoundLib works on a single library at the same time.
If you are already working with a library and you choose the Open command to open another one, 
SoundLib will ask you to save the opened lib, and close it.

If you work with several different libraries, you can launch SoundLib several times. However, SoundLib 
doesn't let you open several times the same library, to avoid incoherence troubles.

When you open a library, SoundLib looks in the midi configuration for the first synthesizer whose type is 
the same as the library one. The founded synth becomes the current device. If there is no such synth in 
the configuration, the library can't be opened.

see also

Displaying the patch list
Troubleshooting



Close (Library menu)

Use this command to close the opened library.
SoundLib asks you if you want to save your library before closing it : 
- if it is a new library, the Save as window is displayed.
- if it is an existing one, SoundLib automatically saves it, with your OK.
If your library has changed since you last saved it, you should save it. If you don't, your work will be lost.

see also
save (Library menu)
Troubleshooting



Save (Library menu)
Use this command to save your work on the opened library.
If you want to change the name or the location of the library before closing it, choose the Save as 
command.
Note :
SoundLib displays the > sign before the library name to inform you that the last changes are not saved.

see also

Save as (Library menu)
Troubleshooting



Save as (Library menu)
This command allows you to save your work and modify the file name and its location, , if you want to.
Dialog box :
File name

Enter the name of the file you want to save. 
SoundLib adds the .SLB extension to libraries. We advise you not to force this extension.

Directories
Select the directory in which is the library.

see also
Creating a library
Troubleshooting



Add bank (Library menu)
Use this command when you want to import patches that are stored on your hard drive or a floppy disk, 
into your library.
Dialog box :
File name

Enter or select the bank you want to import.
SoundLib adds the .SYX extension to the banks files, but you can also enter *.* to open a bank 
with another extension.

Files
Lists all the libraries with the .SYX extension, contained in the opened directory.

Directories
Select the directory in which is the bank.

SoundLib displays a patch card template which lets you pre-classify the patches.
The default category for new imported patches is XX-INCOMING.
You can modify the suggested classification and enter all the informations you want to.
Warning : all the informations you enter on this card will be written on every imported patch card.

Note :
When you import a bank into a library, SoundLib automatically detects duplicated patches and 
only adds new ones.
The messages window informs you about the added patches and those SoundLib didn't add.
If a bank is not loaded, you can only read its name in the messages window, and there are no 
listed patch .

see also

Add directory (Library menu)
Importing patches into a library
How does SoundLib detect duplicated patches ?



Add directory (Library menu)
Use this command if you want to import several banks into the library. These banks must be stored in the 
same directory.
Dialog box
File name

SoundLib suggests *.SYX
If you want to import banks with different extensions, just enter *.* then OK.

Files
Lists all the .SYX banks in the directory.

Directories
Select the directory you want to import into the library.

Note :
When you import a bank into a library, SoundLib automatically detects duplicated patches and 
only adds new ones.
The messages window informs you about the added patches and those SoundLib didn't add.
If a bank is not loaded, you can only read its name in the messages window, but there are no 
listed patch.
You can only load banks whose type is the same as the current device one.

see also

Add bank (Library menu)
Importing patches into a library
How does SoundLib detect duplicated patches ?



Exit (Library menu)
When you quit SoundLib, you are asked if you want to save your work. .
If a library or a bank has changed since you last saved it, you should save it. If you don't, your work will 
be lost.

see also
Close (Library menu)

Save (Library menu)

Save (Bank menu)



Search (Patches menu)
Use this command to search for sounds and display the search result.
The search function is not case dependent.

The default search is done on the whole library, and displays all the patches in the library list.
If the search result contains more than 1.000 patch cards, the search may be truncated (Windows limits 
the number of elements in the list).

You can limit the search to your favourite patches by clicking on YES in the Favourite area.

If you perform a search using the Group by patch mode, all the aliases will be displayed, even if they don't
belong to the entered criteria.

About search criteria :
The search is performed by default on the beginning of each field ; so you don't have to enter the 
complete information, the beginning is enough    (ex : enter A in the name field to find out all the 
patch cards whose name begins with an A or an a).

When you enter a category, the search retrieves all the cards linked to this category and sub-
categories.

You can also search for a piece of text anywhere in a field : just put a star * before the criterion 
(ex : enter *PIA in the name field to find patches as PIANO, BIG-PIANO, OLD-PIA...).

see also
Searching for a sound



View/edit (Patches menu)
Use this command to view a patch card or editing it.

Note : 
If you change the fields :
- Origin
- Redistrib.
- Copyright.
of an alias, all the patch cards linked to the same sound will be changed.
In fact, these data are attached to the patch itself, so they stay identical on every alias patch cards.

see also
Describing a patch 
Modifying a patch card



Sounds of the day (Patches menu)
Use this command to display a random selection of 10 sounds of your library.
If you repeat it, you will have a new draw.

see also
Displaying the patch list



Add an alias (Patches menu)
Use this command to add an additional patch card to a sound.
Very useful when you hesitate between two categories for the same sound !

First you have to select the patch cards you want to attach aliases to. The alias card will be pre-filled with 
original card informations, and then can be changed as you want to.

Note : 
If you change the fields :
- Origin
- Redistrib.
- Copyright.
of an alias, all the patch cards linked to the same sound will be changed.
In fact, these data are attached to the patch itself, so they stay identical on every alias patch cards.

see also
creating an alias
Group by patch (Options menu)



Delete (Patches menu)
Use this command to delete a patch card.
Just delete a card to delete a patch.

Exception : 
If a patch is described by several cards (alias), when you delete one of its cards, you don't delete the 
others, so you don't delete the patch itself. 
To delete it, you must delete all its patch cards.

Note :
When you delete the penultimate patch card, the display is not completely refreshed and you will still see 
the + sign indicating aliases on the last card. To refresh the display, you must perform a new search (If the
+ sign is still there, that means there are aliases left : use the Group By Patch command to find them 
easily).

see also
deleting a patch card



Global/edit (Patches menu)
Use this command to act on several cards simultaneously.
Be careful with this command : all the filled fields will overwrite the previous informations on the selected 
cards. However, empty fields won't be changed.

Note :
If you want to delete a field on several cards, enter "-" in it.

see also
view/edit (Patches menu )
modifying several patch cards



Global/delete (Patches menu)
Use this command to delete several cards simultaneously.
Be careful with this command : all the selected cards will be deleted simultaneously !
If you deleted too many cards, close the library without saving changes and open it again (the last 
unsaved changes will be lost).

see also
delete (Patches menu)
deleting several cards



New (Bank menu)
Use this command to create a bank.
SoundLib automatically names it newbnk00.SYX
The bank name appears :

We advise you to rename it with a more significant name.
To do that, choose the Save as command.

The number of patches contained in the bank is displayed beside the name. This number depends on the 
synth type.

see also
Building a bank



Open (Bank menu)
Use this command to open an existing patch bank
Dialog box :
File name

Enter or Select the name of the file you want to open. 
Enter *.* to display all the file names.

Files
Lists all the banks of the current directory having a SYX extension.

Directories
Select the bank directory.

Note :
SoundLib only works on one bank at the sime time. If you choose the Open command while a bank is 
already opened, SoundLib will suggest you to save it and close it. If there are no changes since you last 
saved it, SoundLib will automatically close it, as soon as it opens the second bank.

If you want to display several banks simultaneously, you can launch SoundLib as many times as you 
want.

When you open a bank, SoundLib looks in the midi configuration for the first synthesizer whose type is 
the same as the bank one. The founded synth becomes the current device. If there is no such synth in the
configuration, the library can't be opened.
Opening a bank can fail if it has been built by another program, building banks which are not compatible 
with SoundLib .

see also
Building a bank
Troubleshooting



Close (Bank menu)
Use this command to close the opened bank.
SoundLib asks you if you want to save your bank before closing it : 
- if it is a new bank, the Save as window is displayed.
- if it is an existing one, SoundLib automatically saves it, with your OK.

If your bank has been changed since you last saved it, you should save it. If you don't, your work will be 
lost.

see also
Save as (Bank menu)



Save (Bank menu)
If your bank has changed, use this command to save the opened bank.
If you want to change the name or the location of the bank before saving it, use the Save as command.
Note :
SoundLib displays the > sign before the bank name to inform you that some changes are not saved.

Patch banks are saved as sysex messages, which lets you use them with other midi softwares.

see also
Save as (Bank menu)



Save as (Bank menu)
This command lets you save your patch bank and modify its name and its location.
Dialog box :
File name

Enter or confirm the name of the file you want to save. 
The .SYX extension is appended to the banks except if you forced another extension.

Directories
Select the directory in which the bank must be saved.

Patch banks are saved as messages sysex, which allows you to use them with other modi softwares.

see also
Building a bank



Save single patch (Bank menu)
Use this command to extract a patch and save it in a separate sysex.

see also

Creating a single patch bank



Copy to Cakewalk (Bank menu)
Use this command to select easily your patches from Cakewalk.

The Cakewalk path must be correctly configured.

see also

Copying a bank into Cakewalk



Add bank to lib (Bank menu)
Use this command to import a bank into your library.
SoundLib suggests you fill a patch card template for the imported patches. This template lets you pre-
classify your patches. If you don't, patches will be classified in the XX-INCOMING default category.

If you want to stop the operation, click ABORT.

SoundLib automatically detects duplicated patches and displays a message window to tell you which 
patches have been imported or not.

see also
Importing patches into a library



Add selected patches to lib (Bank menu)
Use this command only to import some patches in your library and classify them at once.

First, select the patches you want to import. For each imported patch, a card is displayed (pre-filled with 
the patch name, its origin an the XX-INCOMING category).
You can hear a sound by clicking on the TEST button and modify fields you want to.
If you press OK, the patch will be added to the library. If you press Next, the patch is not added and you 
go to the next patch. If you press Cancel, the remaining patches (including the current one) are not added
to the library.

Note :
If some selected patches were already in the library, theirs cards won't be displayed and they won't be 
added again. However these patches will be listed in the messages window.

see also
importing patches into a library



Send (Midi menu)
Use this command to send the loaded bank to the current synth.

You can stop this operation by clicking on Abort.

warning : 
If you changed some patches, don't forget to save the internal bank of your synth before sending another 
one. In fact, when you send a bank, it will overwrite the synth one.

see also
sending a bank to a synth

Troubleshooting



Receive (Midi menu)
Use this command to import patches from a synthesizer. If you want to receive a bank from another synth 
than the current one, you will have to set ti current in the midi menu.

You can stop the operation by clicking on Abort.

When the operation is over, SoundLib displays under the bank area :

Note :

SoundLib does send bank request to the synthesizer. So don't care about controlling the sending from the
synth, except if the Midi out port of SoundLib for this synth is not connected to the Midi in port of the 
synth.

see also
Importing patches from a synthesizer 

Troubleshooting



Configure (Midi menu)
(This command is also accessible by the Midi devices button from the SoundLib configuration window.

Use this command to declare your synths to SoundLib.

Midi Configure dialog box :
Midi devices

lists the installed synths in your configuration
New

lets you install new synths
Edit

lets you modify the parameters of an installed synth.
Shorcut : just double-click on the synth in the list.

Delete
deletes a synth from the configuration

Set current
lets you define which device you want to work with.

Configure Midi device dialog box :
To modify the parameters of a listed synthesizer :

Type
Select the type you want to install. If the type you are looking for is not listed or if you want more 
details about a particular type, take a look at the synth list.

Name
The Name field lets you personalize your synth name. This field is displayed in the window title to 
identify the current synth.

Midi in / Midi out
Select the Midi card the synth is connected to.

Center patches names
Lets you center patch names in banks built with SoundLib.

Base channel
Defines the base channel number given to this device.

see also
Defining the midi configuration



Group by patch (Options menu )
Use this option to identify aliases cards.
This option must be activated BEFORE starting a search in the library.

SoundLib displays a number before each card name. Cards owning a + sign and the same number, 
describe the same patch.

When SoundLib performs a search using the Group by patch mod , it displays all the aliases of a patch, 
even if these cards are not directly matching the search criteria.

To go back to the normal display mode, desactivate the option.

Note :

As SoundLib searches all its aliases for each patch, the search is slower using the Group by patch mode 
than in the normal one.

Patches are numbered following their arrival order in the library. So the patches recently added to the lib 
are at the end of the list.

see also
Displaying patch aliases



Show categories (Options menu)
Use this command to display the category list.

Very useful when you want to describe one or several patches and you hesitate on the location of a sub-
category.

Choose this option before opening a patch card, in order to view the list and the card simultaneously.

As this option displays the category list of the current library, you can't use it if there is no library opened.

see also
Displaying the category list



Add default categories (Options menu)
Use this command to add the new categories you created into your library.

see also
updating the category list



Check library (Options menu)
Use this command if data contained in the library seem wrong or if your file is damaged (for instance if 
white lines appear in the library area).

This command checks each card of the opened library and, if possible, repares errors.

In all the cases, the messages window will keep you abreast of the operation result.

see also
Troubleshooting



Enter registration code (Options menu )

This command lets you access legaly to SoundLib and removes the reminder screens which appears 
after the end of the trial period !

You must enter informations exactly as you received them, following your registration, including upper and
lower case.

Boîte de dialogue :
Name : enter your first name and last name.

Code : enter the registration code you received.

Click OK to confirm.

see also

Registration informations



Tips

Here are some tips to use SoundLib better :
Classifying lots of patches
How does SoundLib detect duplicated patches ?
Deleting a field on several patch cards simultaneously
Importing patches quickly into a library 
Opening a bank or a lib from the File manager or the Explorer
Selecting patches in the library list
Shortcuts
Working simultaneously with several synths
Working safely



Classifying lots of patches
If you have hundreds of patches, first you can sort out patches by indentifying instruments names.

Example :
Sounds close to piano often contains in their names "PIA" or "PNO".

1. Choose Search in the Patches menu 

2. In the Name field :
Enter the first letters of an instrument name :
example : for piano, you can write "PIA" or "*NO"

3. Choose OK
=> Soundlib displays the search result.

4. Classify them :
Select the whole sounds with your mouse.
Choose Global/edit in the Patches menu .
In Category fields, choose Instrument then Piano.

see also

displaying the category list



How does SoundLib detect duplicated patches ?
When you import new patches into your library, SoundLib automatically detects duplicated patches :

=> A sound which is identical to a library one will not be imported, even if its name is different than 
the library sound name.

=> A homonym patch (same in name but differently programmed) will be imported but will have a 
different version number.

see also

importing patches into a library



Importing patches quickly into a library 

1. Group all the banks in one directory.

2. Choose Add Directory in the Library menu.

see also

creating a library



Deleting a field on several cards simultaneously
To delete a field on several cards using the Global edit mode (Patches menu ), enter the "-" sign in this 
field (or select it in a is a scrolling list field).

see also

modifying several patch cards



Selecting patches in the library list
You can select adjacent or non adjacent patches quickly :
adjacents patches : 
1. Click on the first patch you want to select
2. Press the Shift key : hold it down
3. Click the last patch you want to select
4. Release the Shift key
=> Your selection is done

non adjacent patches :
Click on each patch holding down the CTRL key pressed.

see also

other tips



Opening a bank or a lib from the File manager or the Explorer
When you work with the File Manager or the Windows 95 Explorer, you can open a bank or a library just 
double clicking on it : a new SoundLib window will be opened !



Working simultaneously with several synths
If you want to work with several synths or several libraries, just launch SoundLib several times by clicking 
on its icon or by selecting it in the Windows 95 start menu.



Shortcuts
To display a patch card, just double click on it in the library list.
To test several sounds select them in the library list or the bank list, and press the Test button : 
everytime you click Test, the next selected sound is sent to the synth. After the first Test you can also 
press on the space bar.

see also

others tips



Working safely
This section explains you how to save your data and gives you some use advises.
As any software using sensible data, you should back-up regularly your data (libraries and banks) on the 
support of your choice.
To back-up a library : first you have to close it, if it was opened in SoundLib. (don't forget to save 
modifications). Then, just copy mylib.slb file (supposing mylib is the name of your lib) using the File 
Manager or Windows 95 explorer.

You will notice .jnl files in your working directory : these are work files you don't have to back-up. 
However, never try to delete the jnl file of an opened library !

If the library is too big to fit in a single floppy disk :

There are several solutions :

You can compress the library using a compression tool (PKZip, WinZip, gzip...). Some of these tools can 
even split a big compressed file on several floppy disks.

Use a back-up program (ex : MS-DOS or Windows 95 backup).

To save a bank just copy the .syx file. 

Note : You should also keep a copy of your original banks on a floppy disk.

Cautions :
If you just modified sounds in the internal bank of your synth, save them on the computer before sending 
another bank (Send in Midi menu). In fact, when you send a bank, it will overwrite the synth one.

TEST button :
This button sends a patch to the synth, and overwrites the edit buffer. So, save your work if you were 
editing a sound.
On the Kawai K1, K1m, K1r, K1II synths, there is no edit buffer addressable by Midi, so on these synths 
the first location of the internal bank is overwritten when you use the TEST feature.

see also

others tips



Basic concepts
SoundLib lets you build quickly your own sounds libraries where you can easily find the sounds you are 
looking for. You can also build banks and send them to your synths.
The main screen has two areas :
Click on this picture to know more about each part of the screen :

Here is the principle of SoundLib : 
You can store all your patches in a single library. Each patch is described by a patch card with several 
criteria. These cards let you classify your sounds and perform searches in your library.
This is a patch card :
Click on this picture to know more about each field :



Sometimes, it is difficult to describe a sound only in one way : so you can fill in several cards for the 
same patch.

Above the Library area, SoundLib displays the number of cards and the number of sounds you have in 
your library.
Exemple : 

So a sound can be described by more than one card. We talk about alias.
In the Library area, you can notice that sounds described by more than one card are followed by a + 
sign.
Exemple : ANGELICA patch



However a same patch can't be stored twice in the library : SoundLib automaticaly detects duplicated 
patches and does not add them to the library.

SoundLib also manages version numbers.
When you build your library, you are going to load banks from many origins (synths, external banks...). 
Sometimes, you may find homonyms in those banks. (for instance, if someone took an existing patch, 
modified it and save it without renaming it).
So, SoundLib adds a version number to let you distinguish these sounds in your library.
Exemple : APOLLO and ANGELBREATH patches.

Now you know the basic concepts of SoundLib. So you are ready to start !



Library area

Library display area. Allows you to view a part or the whole library.



Bank area

Bank display area. Allows you to view its patches.



Write

This button lets you copy the selected patches from the library to the bank.



Test

This button sends a patch to a synth, which allows you to hear and play it.



Patches

Number of patches in the library.



Cards

Number of cards in the library.



Name of the library



Alias example 

ANGELICA is also classified in the Voice/Female category



Alias example

ANGELICA is also classified in Voice/Choir category



Homonym example

There are 2 different patches named CHORALE-2



Homonym example

There are 3 different patches named ANGELBREATH



Alias example
ANGELICA is also described in the Voice/Female category and in the World/Asia category (named 
BREATH).
These 3 cards have the same number : they describe the same sound.



Alias example
ANGELICA is also described in the Voice/Choir category and in the World/Asia category (named 
BREATH).
These 3 cards have the same number : they describe the same sound.



Alias example
BREATH is also described in the Voice/Choir category and World/Asia category (named ANGELICA.
These 3 cards have the same number : they describe the same sound.



> library : unregistered modifications
The sign > informs you the library has been modified.
Choose Save in the Library menu to save modifications.



Menus
See Menus to have more informations about commands.



Name of the bank



> bank : unregistered modifications
The sign > informs you the bank has been modified.
Choose Save in the Bank menu to save modifications.



Number of patches
The bank size depends on the synth type.



Glossary
Alias
Bank
Base channel
Library
Category
Criterion
Duplicated patch
Patch card
Homonym
System exclusive
Version



Library
Place where you store all your sounds, located on your hard drive. You can store about 7,000 patches in 
a single library.



Bank
Storage area with limited capacity, directly loadable into a synth. Its size depends on the synth type 
typically, a hundred patches (on average).



Patch card
Each sound can be described by a patch card. This card offers several criteria of classification (name, 
category, origin, favourite or not...) and a searchable comments area (where you can also make a search 
for a sound).
A patch can be described by more than one card (cf alias).
More about the patch card.



Sound alias 
Several cards can describe the same sounds. These cards are called aliases. In the Library area, the 
name of the sound is followed by a + sign.



Version
A different version number is given to homonym patches. This number is automatically managed by 
SoundLib.



Homonym
Patch that is the same in name as another, but different in hearing.
As they are different sounds, homonym patches have different version numbers.
Very usefull when you want to create variants of a patch !



Criterion
Name, category, comments, origin...Each element of a card can be used as a search criterion.



Base channel
This is the midi channel used to send System exclusive messages to the synth
It must be the same both in the synth and SoundLib (*).
Depending on the synth type, this channel can also be called "device number", "device id", "Unit channel",
"midi channel"..
(*) SoundLib Midi channels are numbered from 1 : if your midi device numbers from 0, you must add 1 to 
SoundLib base channel.



System exclusive (sysex)
Kind of midi message used to send specific data to a midi device : patches, system parameters...
A midi device only handles the sysex of its instrument type, whereas others messages (for instance midi 
notes) are understood by every kind of instrument.



Category
Each patch can be classified in 1 category and 2 sub-categories.
Default categories offered by SoundLib are close (but not limited to) the General Midi norm.

The 6 main categories are :
- instrument : 

Classic instruments, except drums which have their own category.
- drums & percussions :

for practical reasons, drums are directly accessible by the 1st level.
- synth :

all the synthetic sounds
- voice :

different kinds of voices
- world :

sounds which make you think of a particular country
- misc :

noises, effects...

Here are the sub-categories :

instrument : 
piano= brass= bass=
piano/classic= brass/sax= bass/fretless=
piano/electric= bass/slap=

flute=
string/violin= organ/church=
string/viola= woodwind= organ/jazz=
string/cello=
string/contrabass= guitar/classic= chroma-perc/bell=
string/pizzicato= guitar/electric= chroma-perc/marimba=
string/ensemble= guitar/distortion= chroma-perc/music box=
string/harp= chroma-perc/xylophone=

ensemble=
drums & percussions :
/drums & percs=
/drums & percs/tuned=
/drums & percs/synth=
synth :
analog= lead=
digital= dirty=
fm= inharmonic=
strings= resonant=
strings/breath= space=

voice :
/voice=
/voice/male=
/voice/female=
/voice/choir=
world=
america (north)=
america (south)=
africa=



asia=
europe=
oceania=
misc=
animal= nature/waves= mechanical/car=
animal/bird= nature/wind= mechanical/engine=
animal/dog= nature/thunder= mechanical/siren=
animal/cat=

effects=

If you feel like creating new ones, see Creating a category.



Duplicated patch
Same patch (same hearing) than a patch that is already in your library, with the same name or a different
one.
Everytime you load patches into your library, SoundLib detects duplicated ones and does not add them.



Registration informations
SoundLib is Shareware, not free software. 
You are hereby granted a right to use SoundLib for evaluation purposes without charge for a period of 30 
days.

Unregistered use of SoundLib after this evaluation period is in violation of international copyright laws. 
For more informations, please read the license agreement.

Benefits to registered users include :
- Free technical support,
- Free upgrades (support for new synths, enhanced functions...),
- New products information,
- Removal of the reminder screen that appears once the trial period expired.

How to register SoundLib :

The cost of SoundLib is $49 US(*) plus an additional $5 US(*) to receive the last version on disk.

When registered, you will receive (by e-mail or postal mail) a receipt including your registration code that 
will remove the reminder screen.

The prefered method of payment is via credit card :

- You can fill in the registration form and send it by postal mail,
- On-line registration is also available via Internet on the SoundLib Home Page :
http://www.webcom.com/playloud/SoundLib

==> Please do not use e-mail to send credit card numbers, as this is unsecured !

Sorry, but checks can be accepted only if drawned in FF on a French bank.

(*) based on an average rate of $1 US = 4.9 French Francs.

Print the registration form on your printer by selecting "Print Topic" from the Help File Menu.



SOUNDLIB v1.01 REGISTRATION FORM
On-line registration is also available via Internet on the SoundLib Home Page :
http://www.webcom.com/playloud/SoundLib

Mail this form to :
(Print this form on your printer by selecting "Print Topic" from the File Menu.)

Christophe LE BRASSEUR
27 avenue de la Croix du Capitaine
Bat. C
34070 Montpellier - FRANCE

Please print or write out : 
Date ____________________________________________
Company Name ____________________________________________
Your name ____________________________________________
Address ____________________________________________
City/State/province ____________________________________________
Country /Postal code ____________________________________________
E-mail address ____________________________________________
Phone ____________________________________________

Number of copies_____ X 240FF = FF________
($49 US*)

Add an additional 25 FF ($5 US*)
to receive the program on a 3.5" disk. FF________

Total FF________
(*) Prices are given at the average rate : $ 1 US = 4.9 French Francs

Payment by :
Credit Card : Master Card _________ Visa ________ Eurocard ______________

Expiration date __________________________________________
Card number ___________________________________________
Card issued to __________________________________________

Check : to : Christophe LE BRASSEUR
sorry, but it must be drawned in FF on a french bank

Signature :___________________



_______________________________________________________________________________
Optional :

How many synths do you own ?____________________________________________
Which ones ? ____________________________________________

Where did you get your copy of SoundLib ?
(web site, ftp site, BBS...) ____________________________________________

Comments ? suggestions?
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

THANKS FOR YOUR SUPPORT !



License agreement
SoundLib(TM) v1.01
Copyright (c) 1995 C. Le Brasseur.
All rights reserved.

The registration form can be found in the application help file.

You should carefully read the following terms and conditions before using this software.    Unless you have
a different License Agreement signed by Christophe Le Brasseur, your use of this software indicates your 
acceptance of this License Agreement and warranty.

1) Unregistered version

SoundLib is Shareware, not free software. You are hereby granted a right to use SoundLib for evaluation 
purposes without charge for a period of 30 days. If you use this software after the 30 days evaluation 
period, a registration fee is required.

Unregistered use of SoundLib after the 30-days evaluation period is in violation of international copyright 
laws.

2) Distribution

Provided that you verify that you are distributing the Unregistered version (select About from the SoundLib
Help menu to check) you are hereby licensed to make as many copies of the Unregistered version of this 
software and documentation as you wish; give exact copies of the original Unregistered version to 
anyone; and distribute the Unregistered version of the software and documentation in its unmodified form 
via electronic means.    There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission, with one exception:    Disk Vendors approved by the 
Association of Shareware Professionals are permitted to redistribute SoundLib, subject to the conditions 
in this license, without specific written permission.

3) Registered Version

One registered copy of SoundLib may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by 
multiple people, but not both.

You may access the registered version of SoundLib through a network, provided that you have obtained 
individual licenses for the software covering all workstations that will access the software through the 
network. For instance, if 8 different workstations will access SoundLib on the network, each workstation 
must have its own SoundLib license, regardless of whether they use SoundLib at different times or 
concurrently.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    
SOME STATES DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO THIS DISCLAIMER 



MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY FROM STATE 
TO STATE OR BY JURISDICTION.

Limitation of liability

In no event shall the author or its suppliers or resellers be liable for any loss of profit or any other damage 
including but not limited to special, incidental, consequential or other damages including damages to a 
third party, even if the author shall have been informed of the possibility of such damages, or for any claim
by any other party. 
ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR
REFUND OF PURCHASE PRICE. 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.
The user declares be aware that using this program, he may overwrite some data on its midi devices.
The user must assume the entire risk of using the program.    

Miscellaneous

This Agreement represents the complete agreement concerning this licence between the parties.
This Agreement shall be governed by the Tribunal de commerce of Montpellier, France.

see also

registration informations
registration form



Main screen



Patch card
Each sound can be described by a patch card. This card offers several classification criteria (name, 
category, origin, favourite or not...) and a searchable comments area.

The SoundLib patch card offers 6 functions : 

Name Menu Command
-------------------------------------------------------------------------------------------------------------------
Patch card template Library Add bank

Library Add directory
 Bank Add bank to lib
-------------------------------------------------------------------------------------------------------------------
Search criteria Patches Search
-------------------------------------------------------------------------------------------------------------------
View/edit a patch card Patches View/edit

-------------------------------------------------------------------------------------------------------------------
Edit an alias Patches Add an alias
-------------------------------------------------------------------------------------------------------------------
Delete Patch Card Patches Delete
-------------------------------------------------------------------------------------------------------------------
Global edit of Patches Global/edit
patch cards
-------------------------------------------------------------------------------------------------------------------



Name
Enter a name or a part of a name.

Ex : 
to find patch whose name beginning with PIA, enter PIA
to find patch whose name contains NO, enter *NO



Version
Enter a version number 



Category
Select a category in the list. 
By selecting a category, you also select all the sub-categories.



Favourite
You can limite the search to sounds you particularly like.
By default, SoundLib searches among all the patches, whether they are your favourite ones or not.



Comments
You can search for a comment or a part of a comment, in the same way as patch names searches.

Ex : a comment can be the title of a song.
Title : Searching for Mr Right
Search on the beginning of the title : enter S or searching
Search on the middle or the end of the title : enter *for or *right



Origin
Enter the informations about the patch origin.



Copyright
Enter the informations about the patch copyright.



Redistrib.
Enter the informations about the distribution conditions.



OK
To start the search.



Cancel
To cancel the search.



SoundLib configuration
When you install SoundLib, you are asked to configure your working environment.

1. To set up your synths, choose the Midi Devices option
You must declare at least one synth to make SoundLib work !

2. To modify the working directory, choose Default directory :
Select the new directory and confirm it with OK.
Your new banks and libraries will be stored in this default directory. It's useful to store all your data in it.

You can't use a floppy disk or a ramdrive as a working directory.

3. To send patch banks to Cakewalk, you must confirm to SoundLib which directory is the Cakewalk 
installation one :
Select the right directory and click OK.

To modify SoundLib configuration afterwards :
Choose Configure in the Options menu.



Midi devices configuration 
You must declare to SoundLib which synthesizers you want to use.

So, when you create a bank, a library, or when you exchange patches (Midi/send or Midi/receive), 
SoundLib will know which synth it talks to. 

You can do the following instructions using either :
- the Midi Configure menu , 
- Midi Devices in the Options Configure menu.

If you are not used to synths Midi connections, you can see an example.

To declare your synthesizers :

1. Choose Configure in the Midi menu.
or Midi Device in the Options Configure menu.

2. Choose New
=> SoundLib displays the midi device configuration. Enter the required informations and confirm 
by OK.

Repeat the operation for every synth.
=> All your synths are listed in the Midi Devices list.

To set the current synth :

If you are configuring SoundLib for the first time, please choose the synth you want to work with now.

1. Select it in the Midi Devices list

2. Click Set Current

3. Click OK.

Afterwards, when you open a library or a bank, SoundLib will automatically detect the synth you want to 
use and will declare it as the current one.

However, when you create a lib or a bank, or when you receive a bank, SoundLib use the current synth 
as default. So if you want to work with another synth, first you must make it the  current synth.

To modify a synth set up : 

1. In the Midi Devices list, select the synth whose set up you want to change.

2. Choose Edit to display the midi device configuration window.

Note :
You can also double-click on the synth, in the list.

see also
a midi configuration example
more informations about SoundLib configuration or midi configuration 
Configure (Midi menu)





Midi device configuration 
This screen lets you define which type of device is connected, which Midi port is connected to it, and 
which channel is its Midi base channel.

1. In the Type scrolling list, select the synth you use. 
(If your model is not in the scrolling list, go to the supported synths list and see if there is a compatible 

device).
=> The selected type is displayed in the Name field, by default. 
The Name field do appear in the Midi Device list. You can change it, for instance to personalize 
your synth name.

2. To center patch names on the display of your synth when you build banks : click Center Patch 
names.

3. Select the In et Out ports of your Midi card. If there is no Midi port in the scrolling lists, you should 
install a Midi driver.

4. Define the device base channel.

5. Click OK to confirm changes.

Set up your synth :
To allow your synth to send or receive patches from SoundLib, check the following points :

- Does the synth base channel correspond to the base channel declared in SoundLib ?

- Is the patch banks reception from SoundLib, authorized ? 
    Some devices need to tune the Sysex reception indicator to ON ;

- The patches memory protection must not be activated.

For the first use, don't forget to save your synth internal bank (for instance using SoundLib) before 
overwritting it with new banks !

For further informations, see your synth manual or the supported synths list.

see also
SoundLib configuration 
a midi configuration example 
Configure (Midi menu)



A midi configuration example
In this example, we show you how to connect several synths to each other, for a usual use, with a 
sequencer on a computer, and SoundLib.

Each device is located on a different midi channel. It is the Base channel.
Here the user has 2 Midi cards.

Synth 1 is a classical connection example : the MIDI IN port of the MIDI B card is connected to the MIDI 
OUT port of synth 1, and vice versa. The data exchanges are possible in both directions and all 
operations are enabled.
ex : SoundLib can send patches to synth 2 and can receive patch banks.

On MIDI A, two synths are connected.
Synth 2 is connected the same way as synth 1 : it can send and receive data from the computer.
Synth 3 is controlled via synth 2. The THRU port of synth 2 is connected to the MIDI IN port of synth 3.
Synth 3 can receive patches from SoundLib, but it can't send data back.



Synthesizers informations
In 1.01 version, SoundLib supports 17 different types of synthesizers, as well as others compatible 
models. 
In the following list, this style shows you the synth type you can select in the Midi Devices list when you 
describe your Midi configuration.
You can also click on a model to have more informations about the way SoundLib works with it.
SoundLib v 1.01 only manages simple patches : "multis", "sample-dumps", "wave-sequences" and 
cartridges are not supported.

Synth type Model Compatible synths
----------------------------------------------------------------------------------------------------------
Casio : CZ1000   :                        CZ101, CZ1000  

Ensoniq : SQ-80   :                           ESQ-1, ESQ-M, SQ-80  
TS   :                                TS10, TS12  
VFX   :                              VFX, VFX-SD, VFX-SD II, SD1  

Kawai : K1   :                                K1, K1m, K1r, K1 II  
K3   :                                K3  
K4   :                                K4, K4m, K4r  

Korg : 01/W                               01/W  
03R/W                            03R/W  
05R/W                            05R/W, X5  
M1   :                                M1, M1R  
M3R   :                             M3, M3R  
T1                                   T1, T2, T3  
Wavestation                    Wavestation SR, AD,...  
X3                                  X2, X3  

Waldorf : Microwave   :                   Microwave  

Yamaha : DX7   :                              DX7, DX7 II, (TX802 ?)  



Casio CZ101, CZ1000
These models don't memorize patch names, so the name field is replaced by the order number in the 
bank.



Ensoniq ESQ-1, ESQ-M, SQ-80
On these models the character set is not standard, so some characters are incorrectly displayed.



Ensoniq TS10, TS12
SoundLib only manages the first bank...



Ensoniq VFX, VFX-SD, VFX-SD II, SD1
Cartridges are not managed...



Kawai K1, K1m, K1r, K1 II
Warning : on these models, there is no edit buffer addressable by Midi ;
so the first location of the internal bank is overwritten when you use the TEST feature !



Kawai K3
This model doesn't memorize patch names. So, the name field is filled with "?" when you load a bank.



Kawai K4, K4m, K4r
Nothing special...



Korg 01/W
Nothing special...



Korg 03R/W
Nothing special...



Korg 05R/W, X5
Nothing special...



Korg M1, M1R
SoundLib only manages 100 patches banks.



Korg M3R
Nothing special...



Korg T1, T2, T3
Sample dumps are not managed.



Korg Wavestation SR, AD,...
SoundLib only works with the first bank.



Korg X2, X3
Nothing special...



Waldorf Microwave
The device number must range from 0 to 15 (SoundLib Base Channel : from 1 to 16).



Yamaha DX7, DX7 II, (TX802 ?)
LIMITATIONS
On these models, you can't load sounds saved with the "Save single patch" command into SoundLib.

TIPS FOR NOVICE DX-7 OWNERS
The remainder of this page, courtesy of Lorne Hammond, an early beta tester !

Let's assume you know very little about the workings of a DX-7. You simply want to move sounds 
between the DX-7 and your computer.    Once they are on your computer you will be able to sort them with
Soundlib. There are a few things you should know about your DX-7 first.

All DX-7 machines have a factory default that protects internal patch memory and system information.    
No matter what you do when editing, they are resetevery time    you turn it on.    It was meant as a form of 
sound insurance.    But it also means you cannot receive or send new patches until you turn off the 
internal memory protection and make the system information avaliable.

MEMORY PROTECTION

Push the button labelled "Memory Protect --    Internal"    It will say "Memory Protection Internal On".    Now
push the button labelled "NO / OFF".    The screen will now show "Memory Protect Internal Off".    

MAKING SYSTEM INFORMATION AVAILABLE

You must make the system information avaliable, in order to both send and receive patch banks.    How to
do this is not documented on the top of the DX-7.It is a secret!    Here is how:

Push the brown Function button and then push the button labelled "Feedback 8".

Push "8" a few times and it changes.    Level one is the MIDI RECEIVE 

channel. Although the DX-7 only sends on channel 1, it can receive on channels 1-16, selected with this 
button and the data slider.

Push "8"again and it now reads"Function Control -- Sys Info Unavail".

Push "Yes/ON".    Now the DX-7 can send and receive patch information through the MIDI cables.    

Push "8" a third time and the DX-7 now asks "Function Control Midi Transmit?".    If you push"Yes/On" it 
will send all 32 sounds down channel 1 to SoundLib.    Before you push that "Yes", be sure that SoundLib 
is set up under the MIDI menu to "Receive".    When you push "Yes" the DX-7 LCD will go blank while 
transmitting.    SoundLib will show the number of voices being received and when complete the patch 
names will appear in the left window on your computer.    Now you can save them on your computer or 
mix and match.

Note : Theorycally, you don't have to transmit the patches from the DX7 like that, as SoundLib issues a 
"bank request" message to the synth, however, I'm not sure that the plain vanillia DX7 understands this 
bank request message as all I got from Yamaha was a DX7 II manual. (C. Le Brasseur)

SENDING TO THE DX-7

To transmit to the DX-7 you need only do two things.    

1) Turn off the default internal memory protection, mentioned above, and make the "Sys Info" available.    



Make it part of your start up routine.

Then simply use the "send" option under the MIDI menu in SoundLib. The DX-7 will display a "MIDI 
Received" message as well.

SOUNDS ON DX-7 CARTRIDGES

For sounds stored on cartridges, you will need to copy them one by one into Internal slots before 
uploading them to your computer. Have you saved your internal sounds first?    They will be lost in this 
process.

Turn off the internal memory protect.    Insert your cartridge and press "Memory Select Cartridge" (Source 
of patch), followed by "1" (sound number 1), then "Memory Select Internal" (Destination for patch).    Now 
hold down the RED "store" button and the location "1" (where to store the sound internally). Repeat this 
for sounds 2-32.    Tedious? I agree, there should be a bulk dump, but anyway, once this is in, you can 
upload it to the computer and sort it around with SoundLib. In addition you now have a safe copy of your 
cartridge sounds.

Tip: To double-check your cartridge/internal copying, go "Internal", then "1", then Cartridge" then "1". Only 
the top half of the LCD should change. Repeat for 1-32 sounds.    Boring, but it catches mistakes, and you
wont have to do this again now that you have a librarian !



Troubleshooting
Here are some problems you may be faced with, and their solutions. You can also read the synths list to 
have some infos on a particular device.

In case of unlisted problem, if you have an Internet access, please consult the SoundLib Home Page : 
http://www.webcom.com/playloud/SoundLib.

Last, if you are a registered user, you may send an e-mail to clebras@ibm.net, specifying your registration
code and you hardware and software configuration.

(You can also send an e-mail if you are not a registered user, but no reply is assured in this case).

Creating a library

Opening a library

Saving a library

Opening a bank

Midi configuration

Sending a bank

Receiving a bank

Using SoundLib with other Midi softwares (sequencers...)

Improving performances



Troubleshooting : creating a library
If you fail to create a library (command new of the Library menu) under Windows 3.1 ou 3.11, it's certainly 
because the share statement is missing in the autoexec.bat file. Here are the instructions to add this 
command.

Share usage :

You have to edit the autoexec.bat file which is in your root directory where you installed DOS (generally, 
c:\ ). Under Windows, you can use the notepad program to edit the file.

Then locate a line with a "PATH" statement, and after that line, add a new line as follow (assuming that 
DOS is installed in the c:\DOS directory) :

C:\DOS\SHARE.EXE

then, save the file, exit the notepad, exit windows, and restart the computer.



Troubleshooting : opening a library
Several reasons can prevent you from opening a library :

The share.exe command is missing (Windows 3.1 in standard mode) :
If you can't either create a new library, see how to add the share.exe command in the autoexec.bat file.

You don't have the good device in your Midi configuration: 
When openig a library, SoundLib looks in the Midi configuration for the corresponding synthesizer.If it fails
to find it, the library is not opened and an error message is displayed. For opening the library, you must 
add a Midi device as indicated in your Midi configuration.

The library is already opened : 
It may happen if you launch SoundLib several times. However, a library cannot be opened twice at the 
same time (contrary to a bank).

The library file is damaged : 
Perhaps did you have some troubles with your hard drive ? In this case, you can open the backup version
of your library :

Choose the open... command from the Library menu. In the Filename field, type *.bak, and then 
press the [Enter] key : Now you can see the backup library list. Select your library in this list and 
press the [Enter] key.

If the backup version can't be opened either, check if you have a backup copy on floppy. If so, copy 
it to your hard drive before opening it.

If the backup copy has been opened, use the Check Library command from the option menu to fix 
any error.

Then choose the Save As... command from the Library menu and save the library with a temporary 
name (for instance foo.slb) and save this library to a floppy disk ! 

When all your troubles are fixed, it will be possible to save foo.slb under its normal name, check 
that this library is OK, and then delete the foo.slb, foo.jnl and foo.bak files.



Troubleshooting : saving a library
If you can't save a library, it's certainly because there is no more space on your hard drive. So free some 
space and save it again.



Troubleshooting : opening a bank
If you have trouble opening a bank, first check that there is a device compatible with this bank in the 
configuration midi.

Otherwise, (exepted the case of a damaged file) the bank structure may not be compatible with SoundLib.
That may happen when another program produced the bank. In this case, you can use this other program
to load the bank on your synthesizer, and then import the bank into SoundLib using the Receive 
command from the Midi menu.



Troubleshooting : Midi configuration
If no Midi port is displayed in the Midi in and Midi Out lists when configuring a synthesizer, you must add a
driver for your Midi card. Then, configure your Midi instruments again in SoundLib (After adding the first 
Midi driver, you have to validate by OK the configuration of each of your devices).

Under Windows 3.1 ou 3.11 :
1) Close all running programs.

2) In the Program Manager open the Main group, and then the control panel. 

3) Choose the Drivers icon, and then the Add... button.

4) Choose the appropriate driver from the list (for instance Sound Blaster or MPU-401).

5) If you can't find a driver for your Midi card, you certainly have it on a floppy disk. Choose Unlisted or 
updated driver and specify its location.

6) You may have to tune I/O addresses and interrupts according to your hardware (beware of conflicts !). 
If you have to change these settings later, just select the driver from the list and press the Configure 
button.

7) Then, restart Windows by pressing the Restart Now button.

Under Windows 95 :
Click the Start button, and then point to Settings. 

Click Control Panel, and choose the Add New Hardware item.

Then follow the instructions of the Assistant.



Troubleshooting : sending a bank
Several parts are implicated in Midi communications : SoundLib, software and hardware environment, 
Midi cables and your Midi device. Each of these links can introduce troubles ; so here are some hints !

If the transfert window is not displayed or disappeared immediatly when you clik Send... in the 
Midi menu :

Midi communications may be affected by other running Midi softwares. If this is the case, close the 
other Midi softwares.

Otherwise, you may not have any Midi port installed on your system :

In SoundLib choose Configure from the Midi menu and double-click on a device of the list. If the 
Midi In and Midi Out lists are empty, then you must add a driver for your Midi card.

If data are sent by SoundLib but never reach synthesizer :
Check that the Midi cables are properly connected,

Check your instruments configuration : are settings coherent between the SoundLib Midi 
configuration and the synthesizer ? Did you authorize sysex reception and turn off write protection 
on your synthesizer ?

Are you sure that your Midi card and its drivers are properly configured ? Are you sure that there 
isn't any address or interrupt conflict ?

Can you transmit to other synthesizers ?

If data are sent by SoundLib but some errors occurs on your synthesizer :
Are your Midi cables clean ?

Are you sure that your Midi card and its drivers are properly configured ? Are you sure that there 
isn't any address or interrupt conflict ?

Can you transmit to other synthesizers ?

Is there any update of your card drivers that you could try out ?



Troubleshooting : receiving a bank
Several parts are implicated in Midi communications : SoundLib, software and hardware environment, 
Midi cables and your Midi device. Each of these links can introduce troubles ; so here are some hints !

If the transfer window is not displayed or disappeared immediatly when you click Send... in the 
Midi menu :

Midi communications may be affected by other running Midi softwares. If this is the case, close the 
other Midi softwares.

Otherwise, you may not have any Midi port installed on your system :

In SoundLib choose Configure from the Midi menu and double-click on a device of the list. If the 
Midi In and Midi Out lists are empty, then you must add a driver for your Midi card.

If first data are properly received by SoundLib but errors occurs afterwards :
You can increase the value of the MIDI_IN_BUF_SIZE parameter (normally this parameter is tuned 
by SoundLib during the install process) :
Open the soundlib.ini file from the SoundLib install directory and locate the MIDI_IN_BUF_SIZE 
parameter.
Increase the value of this parameter to 3500. There is no need to set a higher value with 
synthesizers currently managed by SoundLib.

If troubles are still there :
Are you sure that your Midi card and its drivers are properly configured ? Are you sure that there 
isn't any address or interrupt conflict ?

Is there any update of your card drivers that you could try out ?

If SoundLib receives no data :
Check that the Midi cables are properly connected,

Check your instruments configuration : are settings coherent between the SoundLib Midi 
configuration and the synthesizer ? Did you authorize sysex reception and turn off write protection 
on your synthesizer ?

Are you sure that your Midi card and its drivers are properly configured ? Are you sure that there 
isn't any address or interrupt conflict ?

Can you receive from other synthesizers ?

Other reception troubles :
It may happen that Midi reception works properly but that you are unable to abort ; especially with 
rather slow computers (ex 386 SX) or with some soundcards.

If you run Windows 31, you can try working in Windows standard mode instead of enhanced mode 
(standard mode gives better performances). If you decide to switch to standard mode, please 
check that  share.exe must be in the autoexec.bat file.



Troubleshooting : using SoundLib with other Midi softwares
When a sofware needs to communicate via Midi under Windows, it must open a Midi port. However, 
standard Midi drivers of Windows 3.1x do not allow the same Midi port to be open several times... So if a 
software keeps Midi ports opens for itself    (as sequencers usually do), no other software can use these 
ports at the same time.

However, other drivers, that can be opened by several programs at the same time are provided with some
software or hardware :

For instance, Cakewalk includes drivers for MPU-401 compatible cards. These drivers allow the Midi Out 
port to be opened several times : using them, your can Test patches, or send banks on your synthesizers 
with SoundLib while Cakewalk is running. But as the Midi In cannot be opened twice it is not possible to 
receive a bank from the synthesizer while Cakewalk is running.

Some Midi cards (as Music Quest ones) have their own drivers that allow several softwares to use the 
same Midi In and Midi Out ports simultaneously. In this case, there is no limitation at all !

Instructions to add a new driver can be found in troubleshooting : Midi configuration. Don't forget to 
remove the old drivers before adding the new ones. And then you have to reconfigure your Midi devices in
SoundLib.

Note :

You can always launch and use several copies of SoundLib without trouble as long as you don't try to 
transfer data via Midi (Midi/send, Midi/receive or Test button) on the same port simultaneously.



Troubleshooting : improving performances
When Group by patch (Options menu) is on , searches are slower : in fact, SoundLib has to retrieve all 
aliases of the patches it displays

After editing or adding a lot of patches, you may notice that the software is slowing down. If so, save your 
work, quit and restart SoundLib. If it is not better, try restarting Windows.

Using a compressed drive can slow down the saving of libraries (for instance on a 386 SX based 
computer). In this case, save your libraries to an uncompressed drive, or if not possible, reduce the 
compression ratio of the drive.




